Using GradeQuick Web

Teacher Guide

This guide will walk you through the setup and use of GradeQuick Web. It highlights Web-
specific functions and differences between the web and network editions of GradeQuick. It is
available from the Command Center at Edline, and also on your GradeQuick Web Help menu.

We suggest that you also read the Tutorial -l1llustrated Roadmap for Web, which is also
available on your GradeQuick Web Help menu. This will step you through all of the main
GradeQuick Web functionality and is a good tool to use when first learning the program.

In addition, more detailed descriptions of functions common to both the network and web edition
such as grading methods, calculations or attendance are contained in the GradeQuick Manual
on the GradeQuick Web Help menu.

To get started, read the Setup and Running GradeQuick Web sections.
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l. Setup

Follow these setup instructions the first time you use GradeQuick Web on any computer:
Get the GradeQuick Plugin

1. Log in to Edline. You should see these new options in your Command Center: Semester 1
GradeQuick Web, Get GradeQuick Plugin, and GradeQuick Web Help. If you do not
see these options, contact your school’s GradeQuick Web administrator.

2. Click Get GradeQuick Plugin.

) At a Windows computer, click Run. Read and
follow the prompts to complete the download and
Command Center, installation of the plugin.
» Semester 1 (08-09) 0 At a Macintosh computer, click Continue. Once
Adeguicklic the GradeQuick plugin image is downloaded:

v Get Gradequick Web
Flugin

a. Drag the blue GQ Web icon to your Home
v Gradequick Web Help Folder.
v Change Password

b. Double-click the GQ Web icon to initialize
the plugin.

v Manage Account

Copyright ® 2008, Edline .
Privacy & Tesms of llee 3. Once you have the plugin, go back to the Command

Center at Edline, and click Semester 1 GradeQuick Web
(or whatever is your current semester) to run GradeQuick
Web.

If you receive any errors or are unable to successfully complete the installation, contact your
school’s GradeQuick Web administrator.

Using GradeQuick Web on a Shared Computer

Windows: If you share a computer with other GradeQuick Web users, and your
computer/network login does not have administrator or power user permissions, each user will
have to click the Setup GradeQuick link prior to running GradeQuick Web. If you are not sure
whether you need to run the setup, click Semester x GradeQuick Web. If GradeQuick Web runs,
you do not have to run the setup again. If you receive an error, click Get GradeQuick Plugin and
follow the instructions to complete the setup.

Macintosh: If you share a computer with other GradeQuick Web users, each user will have to
follow the setup steps above the first time they run GradeQuick Web on that computer.
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GradeQuick Web Plugin Updates

GradeQuick Web will update itself when a new version is available. When you run GradeQuick
and an update is available, you will see a message that updates are being downloaded.
GradeQuick Web will run when the update completes. While updates are generally fast, some
may take several minutes, depending on the speed of your connection.

ll. Running GradeQuick Web

1. Loginto Edline. If you are a teacher at multiple
C d Cent schools, go to the school page of the school for
ommanc - enter which you want to run GradeQuick Web.

v Semester 1 (08-049 .
Gradequick Web 2. In the Command Center, click Semester x

v Get Gradequick Web GradeQuick Web, selecting your current semester.
Plugin It is important that you select the correct semester, or
v Gradequick Web Help your gradebooks will not be correctly updated.

v Change Password

T 3. GradeQuick Web will run, and all of your

gradebooks will open. Your gradebooks will contain
Copyright © 2008, Ediine up-to-date student roster information. When a new
Privacy & Terms of Use class is created for you on Edline, a gradebook will
automatically be created for it, and opened with your
other gradebooks.

Syncing your Gradebooks

All of your gradebook data, including setup and export data, will be automatically synchronized
to the Web regularly. Unlike GradeQuick Network, you do not have to "save" the gradebooks.
When you exit GradeQuick Web, your final changes will be synced to the Web automatically.
This insures that your most current gradebook information is always available from any
computer with Internet access, and that your exported grades and attendance are available to
your administrator to pull back in to your Student Information System.

Copying Gradebook Settings to Other Gradebooks

If you are starting new gradebooks and want to create global settings for all of those gradebooks,
you should set up your preferences in one gradebook and then use Gradebook to Gradebook
Copy to copy to other gradebooks. If you were using Save Settings for this purpose in
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GradeQuick Network, you will find that all options that were available in Save Settings are now
available in Gradebook to Gradebook copy.

To use Gradebook to Gradebook Copy:

1. Loginto Edline, and click Semester x GradeQuick Web to run GradeQuick.

2. Choose one of your gradebooks as your template, and create all of your settings, such as
grade scales and attendance codes, in that gradebook. For instructions on setting all of these
options, see the lllustrated Roadmap on the GradeQuick Web Help menu.

Once all of your settings are complete in this gradebook, select Edit->Gradebook to
Gradebook Copy.

Copy Grade Quick Items 3] 3. Under Copy From, select the
Capy From.. Pl Copy hat.. gradebook that you used for your

Algebral.gbk [1504 137] Grade Symbols

e g (1005 529 E:Segif;ﬁgm;g settings.
ttendance Codes
. 4. Under Copy To, select all other
S gradebooks to which you want to

Score Footnotes
Leszon Plans

copy these settings. To select
multiple gradebooks, use
ctri+click.

5. Under Copy What, select the item
you want to copy, and make any
relevant selections at the bottom of
the dialog.

Grading Preferences
‘Weights

“ ok x Cancel

6. Click OK.

7. Repeat this process for any other settings that you want to copy.

Posting Reports to Edline

You can easily create and send grade, attendance, and missing work reports in GradeQuick Web.
Customizing student progress reports for Edline uses the same procedure in the Print Preview-
Editor as printed student progress reports. Once you have customized the report to display the
information you want, instead of printing the report you will send the report to Edline for
students and parents to view online. When you post reports from GradeQuick, you can send
them from one class at a time or from several classes at once. Both methods are described
below.

1. Run GradeQuick Web. Choose an Edline report by clicking the Post to Edline button on the
toolbar, or selectingReports—=>Edline Reports.
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ost To
Edline

If you click Post to Edline, you will be taken directly to the Student->Standard 1 Edline
Report. If you select Reports—>Edline Reports, you can then choose any one of the six
available Edline reports. Only the Edline Reports can be sent to Edline.

2.

You will see the Print Preview/Editor for the report you chose. In this window, you can
customize and format the report to include the information you want. See your GradeQuick
manual or Help menu for help formatting reports. You can change the content, but not the
fonts, on Edline reports.

Click the world icon on the Print Preview toolbar, or select Print->Send to Edline. You
will see the Send to Edline Options dialog. Make your selection from the options below,
and then click OK.

0 Select Send Current Student to post a report for the current gradebook for only the
student who currently appears on the screen.

0 Select Send Selected Students of Current File to post a report for the current
gradebook for the students whom you have selected in the Print Preview/Editor.

o Select Send All Students of Current File to post a report for the current gradebook
for all students in that gradebook.

o0 Select Send Several Files to post a report for multiple gradebooks and students at
once. Steps 4-6 will explain the process of posting reports for multiple gradebooks at
once.

If you are not sending several gradebooks, skip to step 7. If you are sending several
gradebooks, you will see an informational message that discusses how to select individual
tests. Because you are sending the report for several gradebooks, you will not be able to
select individual tests to send. You have two options to narrow the selection of tests being
sent:

o0 To send tests for a specific term, you can choose the Single Term Only Edline
report.

0 To send tests for a specific date range in the Print Preview/Editor, select
Tests>Select Tests and Subtotals, and enter a date range in the Start Date and Stop
Date fields in the lower right corner.

Click OK on the informational message. You will see the Select Multiple GradeQuick
Files dialog. Choose the gradebooks you want to include.

You will see the Select Students dialog. All students from the selected gradebooks will
appear in the list. Click the Select All button to post the report for all students from the
selected gradebooks, or select students from the list.
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10.

Note: If you have the same student in several files, that student will be listed multiple times,
and must be selected multiple times. A separate report will be posted for the student for each
class; GradeQuick will not create a single report for the student for all classes.

You will see the Edline Report Information dialog. Enter a description (or title) for this
report. The description entered here will appear as the title of the link to the report on Edline,
in the Contents section. If you are posting reports for multiple gradebooks, the same
description will be used for the reports from all gradebooks sent.

If you have already sent reports to Edline, all past reports names will be available from the
drop-down. You can select one of these to use the same name for your report, or type a new
name. If you do re-use the same report name for the same class, then the previous report that
was posted to Edline will be replaced with the new version you are currently posting. If you
use a different report name, then the previous report(s) will remain at Edline until you
remove it. If you are posting progress reports regularly, you will probably want to use the
same name for reports, such as Current Grades, and have the most current report replace
the previous version.

Click Send This Report.

Wait for your browser to launch and bring up the Edline website. This may take a minute or
two, depending on the speed of your computer and Internet connection. You will not have to
log in to Edline.

You will get a status report telling you the number of reports sent. It will tell you the number
of reports added (i.e. sent for the first time), the number updated (i.e. that overwrote an
existing report for the student), and the number that had errors. Below this you will see an
explanation for each error that occurred (for example a student ID might be incorrect). You
should fix any errors and then re-send reports for the students who had errors.

To see the reports you just posted:

On Edline, select the class whose report you want to see.

The report folder (named based on the description you assigned when you posted the report),
will be found in the Contents box on the class home page. Click the folder name to open it.

You will see the name of each student for whom this report was sent from GradeQuick.
Click the student’s name to see the report. The report will look the same as it did in the Print
Preview/Editor in GradeQuick.

You will have the option to modify the contents of the report on the Edline site. However,
the changes that you make will not be transferred back to your gradebooks. Therefore, if you
want to make permanent changes to a student’s grade or other information, you should make
those changes in GradeQuick, and re-send the report.

Note: When students visit the class home page and click on the report, they will only see their
own reports; they will not see other students’ reports. Likewise, when parents click on the
report, they will only see reports for their own children.
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GradeQuick Web Session Timeout

GradeQuick Web will sync your data to Edline every 4.5 minutes, if you have edited data during
that time. If you have GradeQuick Web running and have not made edits to any of your
gradebooks in about 70 minutes, you will be logged out. You will then be prompted to log in
again to continue working. Please note that your data will be saved to Edline prior to the timeout.
The only time that you will lose data that you entered is if you lose your Internet connection
while working in GradeQuick Web, so that GradeQuick is not able to access Edline to
synchronize the data. In this case, the most data you will ever lose is 4.5 minutes.

Differences between GradeQuick Web and GradeQuick Network

All of the functionality of GradeQuick Web is identical to the functionality of GradeQuick
Network, with the few exceptions as explained in this document. Mostly, these exceptions
involve things that you no longer need to do, such as saving gradebooks, and check in/out of
gradebooks to work at home.

If you have been sending grades and/or attendance from GradeQuick back to your Student
Information System, you will still do what you did in GradeQuick Network to send those grades
or attendance. If you selected File->Send, you will do so in GradeQuick Web as well. If your
grades and attendance were sent automatically when files were saved, they will continue to be
sent that way. See your GradeQuick administrator for instructions on sending grades and
attendance at your school.

lll. Managing your Gradebooks

By default, GradeQuick Web creates one gradebook per class. For many teachers, this
represents the gradebooks they need, and no additional gradebook management is necessary.
However, there are some cases in which you may want to create additional gradebooks, remove
existing gradebooks, or organize your gradebooks due to a semester transition. This can be done
on the Web through gradebook management.

Managing gradebooks includes:

e Changing the order of gradebooks in GradeQuick. Gradebooks appear on the
Windows menu in GradeQuick sorted alphabetically by class name. The class name is
the name you see in the Classes list.

e Copying from Other Gradebooks. An option in GradeQuick allows you to copy from a
gradebooks saved to the local computer or from a previous semester at Edline.

e Adding a New Gradebook. Creating multiple gradebooks for a single class. Its two
most common applications are elementary school classes that are not separately

3/11/2009 8
GradeQuick is a trademark of Edline LLC, © 2008 Edline LLC, Chicago, IL, All Rights Reserved. [S-08]



scheduled by subject, and year-long classes on Edline that have separate gradebooks for
each semester.

Uploading Existing Gradebooks. Uploading existing gradebooks from the network
version of GradeQuick into a class (including special case of network gradebooks Saved
to Edline).

Renaming a Gradebook. Gradebooks that were added or uploaded or automatically
created from rosters can be renamed.

Editing Gradebook Options. Here is a series of options you can set to omit gradebooks
from exporting, use with SiteReporter or change their semester assignment.

Reverting to Previous Gradebooks. Using the Recycle bin to restore a gradebook.

Deleting Gradebooks. If you added gradebooks you don’t want to use any longer, you
can delete them.

Changing the order of gradebooks in GradeQuick

The gradebooks appear on the Windows menu in GradeQuick sorted alphabetically by their
name in Edline. The last gradebook opened appears on the screen when you enter GradeQuick.
You can change the order by renaming the gradebooks to sort so that the gradebooks appear in
an order that you decide. Remember that the name you give the gradebook is also the name that
appears on your Edline page so it must make sense to others who have access to your teacher
page. In general, it is recommended that the naming convention should make sense across your
school as well.

1. Click Classes on the right side of your teacher page.

2. Sort the page by Teacher so your classes appear together.

3. Scroll the pages to find your classes.

SREXMCHIP PGR 08-09_51 SE422_2 81 D. Arias Aug 17
MATH 1 08-09_31 MAT12X3_5 51 3. Armstrong Aug 17
MATH 1 08-08_51 MAT12X3_6 51 3. Armstrong Aug 17
FALARE pEE TR o R AT LR
Edit 1-Teach. Assit. 08-09_31 TCHAST_110 31 E. Amold Today
Edit 2-AL GEBRA 08-09_31 MAS11_2 81 E. Arnold Today
Edit J-ALGEBRAN 08-09_31 MAS11_3 81 E. Arnold Today
Edit 4-3R EX COOKBK 08-098_31 SE401_2 51 E. Arnold Today
ERICLISH 10 a2 0g <4 ER21 221 1 ,\!rllnm Ao

ERICI IS 10 na_na <4 ERI124 R 24 1 &rnindala Aun 17

4. Click the Edit button to access the class page.
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noanry

Class Information

asses

1-Teach. Assit. >

TCHAST_110

Class ID:

Class_ ) Fant family - v | - Font size -- & A - X BB
Description: — = — -
B U= === &= v

Welcome to Teach. Assit..

You can specify a graphic image to display.
(EDLINE currently supports graphics in gif, jpg and png file formats)

€ Internet

5. Change the name. In this case, the names are changed so they sort in numbered order 1-4.
6. Click Save.

Of the left below is how the list of classes appears on the teacher’s page at Edline. On the right
the classes are shown on the Window menu in GradeQuick.

01_2.gbk (SE401_2)

Jptions Help

RSN 1 Teach.Assit.-TCHAST_110.gbk (TCHAST_110)
My Classes i 2 Algebrali-MASL1_2.qbk (MAS11_2)
nl 3 dlgebrali-Masil 3.gbk (MAS11 ) St ink
» 1-Teach. Assit il S A debrali SIS g basti_3) “Bnine
(TCHAST_110 51) @ 45ExCaokhk-xSE401_2.gbk (SE401_2)
- ‘iew All Tems——]

v 2-ALGEBRA NI
(MA511_2 51)

» 3-ALGEBRA Il T
(MA511_3 81)

+ 4-SR EX COOKBK
(SE401_251)

Copying from Other Gradebooks
You can copy from a gradebook used in a previous semester or one saved locally.

0 Windows. Use the Load Gradebook(s) option on the File menu in GradeQuick.
0 Mac. Use Load Gradebook(s) available in the Gradebook to Gradebook Copy dialog.
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& GradeQuick Web - SrExCookbk-xSE401_2.pbk (SE401_2)
G Edit Wiew Graph Grading Reports Options Window Help

Imnport 3
Expor! 3

ent 6SSON
orts Infarmation Edit Skills Planner |
Load Gradebookis) 3 '

Sl viewalTems v

Printer setup... Imnport L

e

Exit Alb+F4 ID Export [ B -
LUTTY TS —— B en ok e

(5) from HardDrive. ..

C_m TEMM [5] .

. from Previous Semester. ..
<_m Category Print gradebook
<_m [Date Printer setup... |E.._\

Choose from Hard Drive or from Previous Semester. You will receive this message. Click
OK.

Information

This Feature is intended ta be used For the purpose of Gradebook to Gradebook Copy, Gradebook will be
y opened in read-only mode.

Cancel ‘

If you choose Hard Drive, you will be present with a dialog box from which you can browse to
any location for which you have access.

If you choose Previous Semester, you will be asked to choose the semester you want to access.

S5elect Period [5_<|

Select the zcheduling period you wish b wark, with

]9

The gradebooks attached to that semester will open in Read Only mode.

o Windows. You will be able to see each gradebook as though it was a current gradebook.
It will appear that you can make changes but none of the changes will be saved when you
close the gradebook. You can also print reports from this gradebook.

0 Mac. You will be able to copy from the loaded gradebook, not see or print from these
gradebooks.

3/11/2009 11
GradeQuick is a trademark of Edline LLC, © 2008 Edline LLC, Chicago, IL, All Rights Reserved. [S-08]



Using *Gradebooks to Manage Gradebooks

The remaining gradebook management techniques are done from the *Gradebooks link. Your
Edline Super User/GradeQuick Administrator will choose whether or not to allow you to use
gradebook management. If you do not see the *Gradebooks link under Contents on Edline,
your administrator has decided to hide this option. If you think you need to make any of these
changes, talk to your administrator about making this option available.

Access gradebook management by double-clicking the *Gradebooks folder as shown below:

Fowrld NSO S ial

L B 1. Log in to Edline. Select

» BOYS-ATHLETICS the class for which you
Heta i) want to create additional

J EE_;"”'-'—TH (933_14_0 gradebooks from the My
51) Classes section on the left

+ MINICLASS | side of the page.

(741_10_0 51)

w MIMI CLASS | (741_4_0
51)

¢ STUDY HALL
(960_10_0 31}

Mv Othear Grauns

Help Logout

Contents 2. On the class page, click

the *Gradebooks link from
the Contents section on the
; right side of the page. If
» ASSignments this option is not visible,
» Tests your administrator has
chosen not to make it
available to you.

» ~Recycle Bin

Links

3/11/2009 12
GradeQuick is a trademark of Edline LLC, © 2008 Edline LLC, Chicago, IL, All Rights Reserved. [S-08]



Adding a New Gradebook

In some cases, you will need more than one gradebook per class. Most commonly, this will

happen in these cases:

e In elementary schools, where classes may be scheduled for the whole day, but you

want separate gradebooks for each subject.

e When you have year-long classes on Edline, but want a separate gradebook for each

semester.

Note: If you will be sending grades or attendance data back to your Student Information System,
make sure that you only have one gradebook per class set to export, as you can only send grades
and attendance for one gradebook per class. This is particularly important if your exports are
sent automatically, or sent by your GradeQuick administrator. See the section Editing
Gradebook Options below for information.

3/11/2009

" Select the type 1o add
:E?jﬁsﬁ:ﬂ‘; New Gradsbook | % | Acd |J[ Done |
Salactdll | Unselact &)l Datads W Show 50
_— T 1. Select New
€&]  Englien ook Toasy Gradebook and
E®|  Math ghk Today click Add.
] [em] Sciencegbk Today
seleciall | Unselectal Detals ¥ Show 50 @
Manage Selsctad ltams 100
[ Dedete |
Done
"Grodebooks Selecl e e o odd. .
{1401 41oms) tewGrooemosk v [288] [ome 1| 2 A new gradebook will be created
SelectAl | Unselectsd D> | Showr 5t I for you, named for the class and class
Hame ¢ Madifizd ID
M [Em] English gk Today .
Ed|  Maih gbk Taday
Toca 3. Continue adding and naming
Selec Al | Unsetect Al Detals ][ Show 50 (& gradebooks, until you have all the
i s ers | Oradebooks you V\_/ant for t_hls class.
(Deiete] When you are finished, click Done,
and repeat the process for your other
T classes.
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Uploading Existing Gradebooks

If you have gradebooks that were created with the network version of GradeQuick, that you want
to upload into a class on Edline, you can do this for individual gradebooks. Please note that
GradeQuick Web allows your administrator to migrate all of your GradeQuick Network
gradebooks, so you should check with your administrator to see if the gradebooks are going to be
migrated for you. If a gradebook was not migrated for you, you can upload it as follows:

Sebact this typa 1o add.

(1-1.04 1 items) Existing Gradeboak |~ [ Aad Done | 1- SEIGCt Existing

“Gradebooks
Salact Al | Unselect Al m - ow 50 [+ GradebOOk and CIICk
Hama » Mao-dified Add .
s R, 2. You will be prompted to

Selact All | Linselec M) Datals ¥ | Show 50 |»

browse to locate the

Manage Selected ltems £ 10 gradebook on your
[Deete ] computer or network.
Select the file and click
[_ose ] Add.

Note: If you are uploading a gradebook in order to copy from it such things as test descriptions
or lesson plans, use the option to Load Gradebook(s), previously explained, instead.

were using GradeQuick Network with Edline, and used the Save to Edline feature, the latest
version of one or more of your gradebooks may be on Edline. You will need to retrieve these
gradebooks in order to use them with GradeQuick Web; they will not automatically appear in
GradeQuick Web.

If you have any gradebooks whose most current version is on Edline, make sure to use check-in
from Web to check those gradebooks back in to the network version, before you upload as
explained above. If your administrator will be migrating for you, you should also make sure to
check in all gradebooks from Edline before the migration occurs. Your administrator has a
GradeQuick Web guide that explains the process of gradebook migration.

Renaming a Gradebook

In the *Gradebooks folder, you can rename gradebooks created for you. To Rename a
gradebook to something more personal, like spelling or math, or Algebra 2 Period 6, click the
Edit button next to the gradebook name, and change the Document Title.
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Editing Gradebook Options

The options that can be set are listed below. Click the Edit button next to the gradebook name to
access the following options.

e Scheduling Period — From this page, you can quickly change the scheduling period for
which this gradebook is associated. This option will only display for Year-Long classes.
If your school has year-long classes on Edline, but you have separate gradebooks for each
semester within the class, you can set the scheduling period for your gradebooks so that
only those from the current semester open in GradeQuick Web.

e Pull exports (grades and/or attendance) from this gradebook — By default, this choice
will be checked. If you have multiple gradebooks for a class, you must indicate which
gradebook will be used for exports. This can be especially useful for year-long classes
whose class ID does not change and yet you wish to use a different gradebook per
semester. Remember that only one gradebook per class can be set to export.

Gradebook

Summary Information
Management L

This gradebook is in *Gradebooks
Last Modified- 07/07/07
Gradebook Title: |AHealthTopics ghk
Gradebook Summary
Scheduling Period: | Semester 1 (Same as Class) ¥ | Mare Info

Pull exports (grades and/or attendance) from this gradebook. Kore Info
[ Include this gradebook for SiteReporter.  More Info

These users can open and change this gradebook: Maore Info
ANGLIN, A

[ Save ] [Cancel]

Done 3 € nternat

e Include this gradebook for SiteReporter — If you have SiteReporter at your school, this
option will be checked by default. If you have extra gradebooks in your class that you use
for templates and do NOT want shown in SiteReporter, uncheck it.

e These users can open and change this gradebook — This will allow you to choose
which teacher can open and change a gradebook. In order for a teacher to appear on this
list, they must be added as a member of the class in Edline.

Caution! Allowing more than one teacher to have access to a gradebook at one time will
result in data loss. For this reason, only one teacher should have access to a gradebook at
one time.
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Allowing another teacher to open the gradebook is essential when you want another
teacher to teach your students some of the subjects. Using this feature, only the right
teacher will be presented with the gradebook when they run GradeQuick Web.
Remember, to prevent data loss only one person at a time should be able to open the
gradebook.

If you don’t want a particular gradebook for your class to open by default when you click
your gradebook link, unclick your name. The gradebook will remain, but not open for
you, until you click your name again.

many gradebooks. GradeQuick Web cannot open more than 45 gradebooks and will give
an error message when GradeQuick tries to run. Teachers who have many gradebooks
may find that as the gradebooks grow with more information, that even 45 gradebooks
may not open. Some gradebooks will have to be marked to not open if the teacher is to
be able to use GradeQuick.

Reverting to Previous Gradebook

If you want to revert to the gradebook for the last day you used it (yesterday’s gradebook, if you
use GradeQuick daily), you can do so. The recycle bin holds up to 30 gradebooks for the last 90
days. Previous gradebooks outside these parameters are no longer available for restoration.

1. Log into Edline, and select the class whose gradebook you want to revert, from the My
Classes section on the left side of the page.

2. Click the ~Recycle Bin link from the Contents section on the right side of the page. The list
of gradebooks in the recycle bin includes all gradebooks that you deleted, as well as a
previous copy of your current gradebooks. All gradebooks list the modified date and time, so
that you can select the correct version of a gradebook.

“Gradabooks LW pailo e
(1.2 of 2ilems) Exsting Gradebook [» | Add Dane |
Salact Al | Unselect Al Datasls M| Show 50 =
Hame » Meodified
: Today
O [E= Scenced.gbk Today
t:+|?.-r;1| | Unseledt &) Detasls ¥ | Show 50 |«
Manage Selected [tams 100
[ Delele ]
Dena J
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Bt foki = 3. Once you have found the
Select Al | Unselectal Show 50 % gradebook you want to reSto_re’
Hame Original Location Modified check-mark the box next to it,
O Modernhgvels-Ened1503.0bk Madern Novels\* Grade books 2008-07-21 10:49.53 CDT and CIICk Restore ThIS
i' ] Mol qhi Maodarn Novels1" Gradehones 2006-07-27 104953 COT .
] Hovelsabl Madern Hovels\*Gradebooks 2008-07-20 22:26.48 COT gradebook will be placed back
] English Lit p5.gbk Modern Hovels 1" Gradebobis 2008-07-20 2219.55COT : *
= ModermnNgvels-Engd1503-1.0bk Modern Novels\*Gragdebooks 2006-07-20 22:11.38 COT Into the G radep(‘)OkS fOIder’
O Modembores-Eme1503-1.0bk Madern Novelsi* Gradebooks 2006-07-20 221113 COT and will overwrite a gradebook
0 Moderntioels-Engd 150 0bk Modern Hovels\*Gradebooks 2008-07-20 10208:58 COT H H
: ModermNioes-Ennd 150 100k Modern Niwve s Gradebpois 2006-07-19 16:33:37 COT Of the Same name If there IS One
Seiectall | Linsalgct sl Shew 50 there'
Manage Selected ltems €10
[Restere | [ Mowe Ta..
[ Done

Deleting Gradebooks

If you want to remove a gradebook so that GradeQuick Web does not use it, and you will not
need this gradebook again, you can delete it. You can delete gradebooks that you created, or the
default gradebooks that are created for you. If you want to, you can delete all gradebooks for a
class, so that GradeQuick has no gradebooks for that class. To delete gradebooks:

o 2w rewomsmen i Lhet] o= 1)1 ) og in to Edline, select the class for
v e which you want to delete

TR Todwy gradebook(s), and click the

GEE U e *Gradebooks link in the Contents
B — fos o section on the right side of the page.

Manayy Eelosted Nems Lic 2. Check-mark the gradebooks that

L you want to delete, and click

= Delete.

3. You will be prompted to type the word “delete”, to insure that you intended to delete the
selected gradebook(s).

4. Your selected gradebook(s) will be removed from the list of gradebooks, and sent to the
Recycle Bin. To retrieve a deleted gradebook from the recycle bin, see instructions above for
Reverting to a Previous Gradebook.
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